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Preface

This section gives basic information about this guide, training and support.

About This Guide

This guide describes how to use AVEVA Point Cloud Manager – Viewer projects. Instructions are given for both
PC/laptop and mobile device usage.

Audience

This guide is aimed at new Viewer users and covers the use of the Viewer client. It is assumed that the user
already has access to a hosted Viewer project.

Technical Support

AVEVA provides an online support portal, available 24 hours a day, 7 days a week, for raising and monitoring
support incidents and service requests.

Phone escalation is supported for P1 Critical issues only.

AVEVA Customers can reach the Global Customer Support team using the following methods;

Online Ticketing Portal – AVEVA Helpdesk - https://softwaresupportsp.aveva.com/

Telephone (only for Priority-1 incidents)

Location Toll Number

USA + 1 832 204 5650

UK +44 1223 556 690

Brazil +55 213 094 9855

Malaysia +60 327 180 811

Email - support.operations@aveva.com

Commercial Information

For commercial information please contact your AVEVA Account Manager or AVEVA Point Cloud Manager Value
Added Reseller.
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Supported Hardware and Browsers

Viewer is designed to work with desktops, laptops, tablets, and smartphones. A graphics card/processor
supporting WebGL is required.

Viewer supports the following web browsers:

• Microsoft Edge v25 and above•

• Google Chrome•

Viewer may operate on other browsers but has been optimised and tested for use with the above.
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Using this guide

Viewer projects can be accessed on a wide range of devices and browsers which may differ with respect to user
input.

The graphics below illustrate a user input or control description. If there are any references to selection, flight
control or general use that do not have these graphics, it should be assumed that these relate to standard
desktop or laptop computers.
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Accessing Viewer Projects

To access a Viewer project:

1. On a supported web browser, go to connect.aveva.com. When on this page, select the Sign in button.1.

2. Enter your email address in the Email box.2.

If Single Sign On (SSO) is enabled, after entering your email address the Password field will disappear as your
password will be obtained from the SSO Server. Select the Sign In button to proceed.

3. If SSO is not enabled, enter your password and select the Sign In button to proceed.3.
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A list of accounts that you are authorised to access will be displayed. Simply select the desired account to
enter it.

4. When inside the desired account, select the desired Digital Asset from the Home page.4.

5. Select AVEVA Point Cloud Manager - Viewer to launch the Viewer project linked to the selected Digital5.
Asset. You will automatically be logged into the project using the credentials provided when you logged into
CONNECT.

Google Maps Landing Page

If the project being accessed has a Google Maps landing page:

1. Select AVEVA Point Cloud Manager -Viewer - Maps on the Asset when logged into the CONNECT account.1.

On accessing the landing page, an instance of Google Maps is displayed with a project marker, showing the
location of each project on the landing page. The projects are also listed in the Project Components Browser.
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2. To locate each dataset, either manually zoom in to one of the dataset markers or select the relevant project2.
and dataset in the sidebar.

On zooming into a dataset, each individual scan position within that project is displayed on the map. The
scan markers are coloured based on the elevation of that scan. A key is provided at the bottom right of the
page to show which colour relates to which elevation.

Selecting a project/dataset/scan marker brings up a dialog that displays the details of that project/dataset/scan.
Select the Open button to load the associated Viewer project. You will then be automatically logged into the
project using the credentials provided when you logged into CONNECT.

Viewer supports Google Maps functionality, the licence terms of which prohibit use in certain areas - including
China (a full list can be found at: https://enterprise.google.com/maps/terms/maps-prohibited-territory.html).
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Use of the release in these areas is therefore also prohibited without further review by AVEVA legal and
development teams – please contact https://softwaresupportsp.aveva.com/ for further details.

Signing Out

To log out of a project:

1. Select the Menu Options button (highlighted below) and then select Sign Out. A confirmation dialogue is1.
displayed asking you to confirm if you want to sign out.

 

2. Select Yes to proceed.2.
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The Project Floorplan

A site floorplan is presented upon entry to the project. Viewer supports the use of multiple floorplans which can
either be derived from laser data or from .pdf files. These are typically set to correspond with the site major
elevation changes and are defined by the person creating the Viewer project. Sectional plans can also be used
for side elevations at key points of interest. If a user wishes to switch to a different floorplan they can do so
through the Project Components Browser ‘Floorplan’ tab.

Floorplan movement controls

For desktops and laptops:

Pan – Left mouse click and drag

Zoom – Roll mouse wheel

For mobile devices:

Pan – Finger press and drag

Zoom - Pinch

Note: Viewer floorplans will offer an increased level of detail as the user navigates & zooms to a point of interest.
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If the project being accessed has multi-level floorplans, the extents of the linked floorplans will be shown on the
master floorplan as shown above. Hover over the floorplan extents box to show the name of the linked
floorplan. Double click on the floorplan extents box to load the linked floorplan.

To turn on the display of multi-level floorplans, please enable the Enable multi-level interactivity in floorplan
option under the Floorplan Options menu.

Please note that multi-level floorplans are applicable to PDF floorplans only.

The project scan locations are identified as blue markers on the floorplan. Markers with a red center represent
unloaded scans. Markers with a green center represent loaded scans.

When an area contains a close grouping of scans, the scan sites will be clustered together on the floorplan for
clarity. This will make the floorplan visible even when the project contains many scans. The cluster will display
the total number of scans included. When double-clicked, the floorplan will zoom in and expand the cluster into
individual scan sites.
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The project panoramic image locations are identified as blue squares on the floorplan. Squares with a red center
represent unloaded panoramic images. Squares with a green center represent loaded panoramic images.

The floorplan view can also display the project 3D Markups, measurements, objects and Benchmarks. This allows
the user to determine where they are located within the building or facility, so that appropriate scans can be
opened in which to display them. Items that are currently selected will be displayed in the floorplan.

In order to see Benchmarks in the floorplan please enable the Always Show Benchmarks in Floorplans option
under the Floorplan Options menu.

Loading Scans or Panoramic Images from a Floorplan

To load scans or panoramic images from the floorplan:

• Double-click on a scan site or panoramic image marker (or)•

• Double tap on a scan site or panoramic image marker•
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BubbleView Images & Control

The BubbleView is an intuitive method for viewing and interacting with data from a laser scan. It enables the
user to place themselves at any scan location and visualize the scene as if they are standing there.

The BubbleView provides the user with a dynamic but narrow field of view at any one time, which will reduce
perspective distortion in the image. A BubbleView allows true 360° rotation of the image with both directional
and magnification control. Comprehensive measurement and Markup facilities are also available within the
BubbleView environment.

Viewer BubbleViews are 3D enabled and can display objects, project tags, Markups, objects and measurements.

A mini floorplan window is available in the open BubbleView. This provides a viewing frustum which is updated
in real time to reflect the current field of view. As a user zooms in to focus on a point of interest, the frustum
narrows in unison. This can be toggled on or off in the Options menu.

On the left, you can view up to 5 recent scans that have been opened within a project.

At the bottom of the BubbleView there is a ‘dead’ zone, this area does not contain any laser data. This area can
display a navigational compass by default or a user uploaded image such as a company logo. The upload of the
logo is done through the Upload tab on the Administration page for the project.

Switching Between Colour and Intensity

For colour scans it is sometimes desirable to view the intensity data without the colour overlaid. This can be for
scans taken in poor lighting conditions or if a shadow is obscuring an item of interest.
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To do this, select the colour/intensity switch from the Tools Pill Menu at the bottom of the BubbleView. Note
that this switch will only be present in scans where colour is available.

Loading other scans from within the current BubbleView

In the Floorplan section, we saw how to load a BubbleView directly from the floorplan. BubbleViews can also be
located and launched from within the current open BubbleView. Again, other scan sites are displayed as blue
markers. The markers are scaled according to range – scan sites closer to the current BubbleView are larger; scan
sites further away from the current BubbleView are smaller.

The range of scan locations displayed can be configured by the user through the BubbleView Options. It is
advisable to reduce the range figure on densely scanned projects, so they do not overpopulate the currently
loaded BubbleView with scan site markers.

 

Markers with a red center represent unloaded scans. Markers with a green center represent loaded scans.
Markers with a line through the center (as shown above) represent scans that are obscured from the current
viewpoint.

To load scans from the current BubbleView:

• Double-click on a scan site (or)•

• Double tap on a scan site•

For standard laptop or desktop computers, user control movements are illustrated as follows:

To Pan: Left mouse click and drag

To Zoom: Roll mouse wheel

For mobile devices, user control movements are illustrated as follows:

To Pan: Finger press and drag
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Zoom: Pinch

You can now reverse the direction of Pan in the BubbleView settings in the Options menu.
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Panoramic Images & Control

Panoramic images are a quick and easy way to capture site conditions where 3D functionality (such as
measurements/Markups/model visualisation) is not required. It enables the user to place themselves at any
position and visualize the scene as if they are standing there.

Panoramic images allow true 360° rotation of the image with both directional and magnification control.

Double-click a scan marker to open the related scan.

Please note that 3D related features such as measurements, Markups, model visualisation and the Tools Pill
Menu are not available when viewing panoramic images.

Panoramic image controls

For desktops and laptops:

Pan – Left mouse click and drag

Zoom – Roll mouse wheel

For mobile devices:

Pan – Finger drag

Zoom – Pinch

Center screen – Double-tap on a point of interest
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Accessing the Projects Components
Browser

The Project Components Browser (also known as the sidebar) controls several Viewer features and options.

A simple switch controls the visibility of this menu as shown, at the bottom of the browser. Simply toggle the
Project Components Browser display as required.
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Project Components Browser – Floorplan

Viewer supports the use of multiple floorplans which can be derived from laser data or .pdf files. These are
typically set to correspond with the site major elevation changes and are defined by the person creating the
Viewer project. Sectional plans can also be used for side elevations at key points of interest. The illustrations
below show sectional and building level floorplans.

To show a list of available floorplans within a current project, click or tap the Floorplan tab. To display a floorplan
in the main Viewer window, click or tap the desired floorplan.

To search for a floorplan by name, use the search box at the top of the list.

Go To X, Y, Z Coordinate

This feature enables the user to enter a specific X, Y, Z location and open the best BubbleView to view that
coordinate.

1. Select the Tools Menu button at the bottom of the Floorplans tab to show the Go To window.1.
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2. Enter the desired values in each of the coordinate fields and click the arrow button. Viewer automatically2.
loads the best BubbleView and center on the position specified.
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Project Components Browser – Datasets

Viewer supports multiple AVEVA Point Cloud Manager Server datasets within a single project. This enables easier
structuring and management of point clouds and related data.

1. To show the list of available datasets within a current project, click or tap the Datasets tab.1.

2. To display the list of scans and/or panoramic images within that dataset, click or tap the desired dataset.2.

3. Load the desired BubbleView or panoramic image by clicking or tapping on it.3.

The Calender icon enables the user to select datasets from a range of dates.

The search box enables users to search for a particular dataset, BubbleView or panoramic image by name. Many
projects prefix scan or panoramic image names with building/unit, level, or process name. Using the scan filter in
these situations is beneficial. The filter can be reset using the cross symbol.

If scans within a project contain metadata, the View Metadata for BubbleView icon is displayed at the side of the
scan name. Select the information icon to display the metadata for that scan.
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Viewing Project Benchmarks

Viewer projects can include 3D Benchmarks to help users locate known site positions with ease. The process of
adding these Benchmarks is doneduring the deployment stage by the Project Administrator. This document will
focus on the use of these Benchmarks in the Viewer project.

To access Benchmarks in Viewer:

1. In the Project Components Browser, select the Benchmarks arrow. This displays a list of Benchmarks1.
available in the project. If there is no arrow at the right of the Benchmarks node, it signifies there have been
no Benchmarks added to the project.

2. To focus a current BubbleView on the selected Benchmark, click or tap on a Benchmark name. Double2.
click/tap on a Benchmark to load the best BubbleView to view the selected Benchmark.

3. Select the desired Benchmark in the Project Components Browser to visualize the Benchmark in the3.
BubbleView along with a label showing the Benchmark’s name and 3D position.

Please note that Benchmark support is not available when projects are hosted on Desktop.
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Viewing 3D Modelled Objects

Viewer can display 3D objects from an .xgl, .zgl or .fbx file. This enables users to see the modelled objects
overlaid with the laser data. As objects are truly 3D, they are visible in any scan that can conceivably see them.
Users can interact with the objects to see the object name and navigate to that object in the Project Components
Browser. If there is a hierarchy present in the .xgl, .zgl, .fbx file, this is reflected in the Project Components
Browser.

The process of adding these objects can be done during the deployment stage or after deployment by the
Project Administrator. This document will focus on the use of these objects in the Viewer project.

.

Loading models can be a timely process depending on the size. It is not always relevant to have objects loaded
when interacting with a project. On initially entering the project, the user can choose to stop objects loading by
selecting cancel on the pop up shown in the image below.

To set the loading of modelled objects, go to Options menu > General and toggle the Automatically load objects
on log in switch.
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If objects are not loaded, users get access to key project features quickly. The object can then be loaded by
clicking the drop-down in the Project Components Browser and selecting the object file from the list.

To control the display of modelled objects in a BubbleView, go to Options menu > BubbleView and under
Modelled Object Visibility, select one of the following:

• All - All loaded objects are constantly displayed•

• Disabled - No objects are displayed•

• Selected and Hovered - Displays objects only when they are selected in the Project Components Browser or•
when hovering the mouse over an object in the BubbleView

To access modelled objects in Viewer:

1. In the Project Components Browser, select the Objects node arrow. This displays the hierarchy of the1.
modelled objects file. If there is no arrow at the right of the Objects node, it signifies there have been no 3D
modelled objects added to the project.

2. For groups of objects, a blue arrow is present at the right of the tab. Click the blue arrow to expand the2.
group and display the objects or further groups within it.

3. To highlight a group or object in the BubbleView, click or tap on a group or object. This will also focus any3.
loaded BubbleViews to the center of the group or object.

4. Double click or tap on a group or object to load the best BubbleView for that group or object and focus on it.4.

5. To select a corresponding object in the Project Components Browser, click or tap on an object in the5.
BubbleView. Hover over an object to display its full name in a callout.

If the project has multiple object files associated with it, you can select which model file to load from the
Object File menu. Click the drop-down and select the desired model file.

Note that only one object file can be loaded at a time.
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Using Context Viewer

Users accessing Point Cloud Manager projects through a computer’s internet browser have full access to Context
Viewer. This enables the user to view the project with full 3D representation of the point data, allowing
movement and focusing on key points such as markups. Users also can use fly-through controls on the dataset as
a whole. In this section both methods are discussed.

To access the Context Viewer, datasets must be upgraded to allow the latest functionality. This can be done
through the Project Administration page. For more information refer to sections under Project Page
Administration.

To access the Context Viewer, select the [3D] symbol within the user interface. If the symbol is greyed out, it
shows the dataset has not been upgraded and therefore the Context Viewer is not available.

- Greyed out (Unavailable)

- Bold/Black (Available)

The ability to enter and exit Context Viewer is available through the Properties Panel, Dataset and BubbleView.

When in a BubbleView, select the [3D] icon from the Pill menu to switch to Context Viewer. Select the icon again
to switch back to the nearest BubbleView.

To control view orientation, use the compass in the lower corner of the view. Select a point on the compass to
orientate the view to that direction. You can also double-click any point within the [3D] viewer console to
position the camera around that point and seamlessly move towards that point.

Orbital mode

Orbital mode gives the user the ability to view specific measurements or 3D Markups in context of the wider 3D
point data.
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To open Orbital mode, a markup or measurement must exist. To learn how to add markups and measurements,
refer to the Measurements and 3D Markup sections.

1. Navigate to the desired entity, and if available select the [3D] symbol. This loads Solid Point Cloud with a1.
focus around the entity.

While in Orbital mode, a user can rotate around the position of the entity selected and zoom in and out by
clicking and dragging to rotate and using the mouse scroll wheel to zoom.

The radius of the context viewer is directly proportional to the size of the 3D Markup. Editing the size of the
markup will alter how large an area around the entity is shown while in Orbital mode.

To change the location of the orbit origin, double-click on any arbitrary point.

Pressing a directional key on the keyboard while in Orbital mode switches the user to Fly-through mode.

Fly-through mode

Fly-through mode enables the user to fly through a project. This can be accessed through orbital mode, or
through selection of dataset from the Entity Browser.

To enter through the Entity Browser, select the [3D] symbol.

While in the fly-through mode, users can click to rotate and scroll to zoom like in orbital mode. In addition to
these commands users can navigate using the directional keys on the keyboard. Ctrl moves the view down
vertically and Spacebar moves upwards vertically.

While in the fly-through mode, double-clicking on any annotation like a markup, measurement or benchmark
takes you towards the annotation and enters orbit mode automatically.

To increase the distance covered by these commands the user can hold Shift. The Orbit point tool on the pill
menu enables the user to select a point to orbit around when in fly-through mode.

*Please note the W,A,S,D keys can be used to navigate, however when used in conjunction with the Ctrl and Shift
keys this can prompt the browser to run shortcuts, such as "Save as" and "Close tab". We recommend using the
directional arrow keys.

Controls

Key Function

Left Mouse Button (hold + Drag) Rotates view

Scroll wheel Zoom View

Ctrl (Fly-through only) Pan Downards
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Spacebar (Fly-through only) Pan Upwards

Arrow Keys Move in respective directions

Shift + Other key Arrow Keys Increased speed of pan/move

When in the Fly-through mode, you also have the option to enter walking mode. This mode enables you to
navigate the 3D view while maintaining a good view of the data.

To enter this mode:

1. In the Pill menu, select the Enter walking mode option and double-click on any point. You will be able to see1.
an area in that vicinity to a certain distance. Double-clicking the ground takes you into the floor.

2. To change the elevation, scroll the mouse wheel.2.

3. To change the elevation in the X-axis, hold the middle mouse button and move the mouse in the left or right3.
direction.

4. To change the elevation in the Y-axis, hold the middle mouse button and move the mouse up or down.4.

The walking mode feature is disabled in the Orbit and Panoramic modes.

24.4.0
© 2015-2025 AVEVA Group Limited or its subsidiaries. All rights reserved.

  
Page 28

AVEVA™ Point Cloud Manager Viewer Help Guide
Chapter 13 – Using Context Viewer



Share a Link to Your Current Viewpoint

It is possible to create a direct link to a Viewer project, scan, position and zoom level.

To do this:

1. Select Menu Options and then select Sharelink.1.

2. To copy the link, select Copy Link. Simply paste the link into a supported browser and enter your project2.
login details to navigate directly to the current view.
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Switching Between Full & Tiled Views

Floorplans, BubbleViews and panoramic images can be viewed separately in full screen, or in a tiled viewport
(four maximum).

To switch between the full and tiled views, select the Switch to tile view/Switch to full view toggle .

To load scans in the tile view, simply drag and drop the desired scan from the Project Components Browser onto
the desired quadrant of the tile view.

To display a BubbleView across two tiles, simply drop the scan from the Project Components Browser in between
two tiles.

The name of the scan is shown at the top-left corner of the tile upon moving the mouse cursor into that tile. To
close a tile, select the cross at the top-right-corner of the tile.
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QR Code Scanner

When performing an inspection task in a large facility, it can be difficult to know your location, especially as
facilities can be remarkably similar. To help alleviate this problem, the QR code scanner gives the user a simple
method of localising themselves when using Viewer on a tablet if QR codes have been placed in the facility.

All tablets contain an on-board camera. Once a QR code had been identified with the camera, Viewer loads up
the best BubbleView in and shows the matching item (markup or measurement) in the laser data. The user will
also see their position on the floorplan.

To initiate the QR code scanner:

1. Select the video camera icon at the to- right of the Viewer interface.1.

2. Select allow to enable the browser access to the camera. This only must be done once on https://2.
connections only.

After allowing access to the camera, the scanner window appears.

3. Move the camera over the QR code.3.

If the scanner detects the contents of the QR Code to be Markup that exists in the project, the appropriate
BubbleView is loaded, centered on the linked Markup. The detected Markup name also appears at the
bottom of the scanning window.
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Options

The Options menu can be accessed by selecting the cog at the top-right corner of the Viewer interface. Each of
the options available are explained below.

Help

To view or download the Point Cloud Manager Viewer PDF, select the Help menu.

Taking Viewer Offline

Viewer users can take their projects ‘offline’ for site visits, client meetings or anywhere a reliable internet
connection is not available. This means that a time-limited snapshot of the project and up-to-date Markups/
measurements can be quickly and efficiently downloaded to a compatible mobile device or netbook/laptop.
When finished, this project can either be discarded or synchronised back to reflect any new changes made while
on site.

To prepare an offline session:

1. Open the project on the device being taken to site (wired/Wi-Fi connection required).1.

2. Select the Menu options button from the application bar, hover over Offline and select Create Session. If2.
this button is not visible, then you do not have the required permissions to go offline. These permissions can
be added by your Project Administrator.

3. Select the scans needed for review from the list provided on screen and press Next. Be aware that the3.
amount of data that can be downloaded is limited by your Internet Browser.
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For large projects that need to be accessed in their entirety, an option of downloading ‘compact images’ is
available. The visual degradation of the images is not immediately obvious, but this will offer more efficiency
with respect to storage. It is still possible to create Markups and measurements using compact images whilst
offline.

4. To save a local copy of the Viewer PDF to the selected device for use while offline, select the Download4.
AVEVA™ Point Cloud Manager - Viewer help manual option.

The number of days the offline session is valid for should also be specified. The maximum limit for this field is
set by the Project Administrator in AVEVA Point Cloud Manager.

5. Press Start to begin the download process. This automatically takes copies of all associated floorplans. Please5.
note it can some take time to take projects offline.

Accessing an Offline Session

When the download process is complete, the user can access the offline session by going to https://
viewer.pointcloudmanager.connect.aveva.com when offline.

The Offline Mode tab is displayed. This shows the project name and how much time is remaining until the offline
session expires.

Select Open to access the offline session.
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A pop-up is temporarily displayed at the top of the Viewer interface stating that you are now offline.

You can now interact with your offline session – you can view floorplans, open BubbleViews, view existing
Markups/measurements and create new Markups and measurements (except for pipe diameter measurements).

When you are back online, you can access the online instance of the project as normal. See Accessing Viewer
Projects.

Syncing Markups and Measurements When Back Online

If site Markups or measurements were created while offline, users can synchronize the project when a suitable
internet connection is made.

To do this:

1. Access the online instance of the project as normal. See Accessing Viewer Projects.1.

2. When logged in to the online instance of the project, go to Menu options at the top-right of the Viewer2.
interface.

3. From the Offline menu, select Load stored session.3.
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4. Then from the Offline menu, select Sync back online.4.

5. To begin the Sync process, select Next. A progress bar is displayed to show the sync is in progress.5.

6. When the sync process is complete, a successful message is displayed. Select Done to be taken to the online6.
instance of the project which will now contain the Markups and measurements that were created whilst
offline.

Deleting an Offline Session

If you wish to delete your offline session, go to Options > Offline and select Delete Stored Session. Confirm that
you wish to delete the offline session.

Options menu

The Options menu is categorized as follows:

• General•

• Floorplan•

• BubbleView•

• Sidebar•

• Solid Points•

The following image represents the Options menu as it appears on the Viewer interface:
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General Options

Viewer supports the following working units:

• Meters•

• Millimetres•

• Feet and Inches•

• U.S. Survey Feet and Inches.•

Users can set their preferences with this option. The default units are meters.

The default X,Y,Z coordinate system can be altered to show other commonly used systems, which are:

• Cartesian (X, Y, Z)•

• Northing, Easting, Elevation•

• Easting, Northing, Elevation•

Colourise instead of hide when filtered

When turned on, this option displays a coloured ring around the scan site markers in the BubbleView and the
Floorplan. The ring changes colour depending on whether the scan site marker matches the currently applied
filter. Scan markers which match the currently applied filter have a green ring around them. Scan markers which
do not match the currently applied filter have a red ring around them. Turning this option off will hide any scan
site markers which do not match the currently applied filter.

Colourise instead of hide when filtered turned off:
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Automatically load objects on log in

When turned on, this option automatically loads objects into the project when a user logs in to the Viewer.
When turned off, users will be able to select which object files to load. This is designed so users can open a
project and BubbleViews quickly without having to wait for objects to load unless required.

Invert navigation controls

Toggle this option to set the navigation to follow the direction of the mouse movement.

Floorplan Options
Show legend in floorplan

Control the display of the floorplan legend with this option. This is switched on by default.

Show floorplan BubbleView labels

Control the display of scan site names (labels) in the floorplan with this option.

Drop-down options include:

• Always•

• On Mouse Hover (default)•

• Never•

The illustration below shows why users may wish to select On Mouse Hover for clarity. On less densely scanned
areas however, it may be desirable to label all the scan sites.
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Show floorplan Benchmark labels:Control the display of Benchmark names (labels) in the floorplan with this
option.

Modelled Object Visibility

This option allows users to control the visibility of any loaded modelled objects in the floorplan. Select either All
or Disabled.

Modelled Object Opacity

This option enables users to control the opacity of the loaded modelled objects in the floorplan. Move the slider
to the right to make the objects more opaque. Move the slider to the left to make the objects more transparent.

Enable multi-level interactivity in floorplan

This option enables the multi-level floorplans feature which displays the extents of linked floorplans in a master
floorplan.

Always Show Benchmarks in floorplans

This option enables the user to see project Benchmarks in the floorplan.

BubbleView Options
Show floorplan in BubbleView

This option enables users to superimpose a small floorplan in the BubbleView (bottom right corner). This is
activated by default.

Show compass in BubbleView

This controls the display of the directional compass in the BubbleView. This can often be useful when using
Viewer on a mobile device such as a tablet where screen size is limited. Deselect the switch to hide the compass
in the BubbleView.

Show custom compass image

If the project has a logo uploaded, you can use this option to set the compass image at the floor of the
BubbleView to theproject logo.

Use Default Filter Distance
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Close scan sites are displayed inside the BubbleViews. These are scaled to illustrate which are closest to the
current eye position. If there are too many scan sites, it can be distracting to the user. Change this option to only
show scan sites within the specified range.

Toggle this option to enable the range slider. Drag the slider left and right to display fewer or more scan sites
respectively. Alternatively, double-click on the value to allow manual entry. Type in the desired value and press
Enter to accept.

Max Range of 28 meters applied

Max Range of 8 meters applied

If the floorplan is displayed in the BubbleView, the user can change the size of the floorplan between Normal and
Large. Select the desired option to change.
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Modelled Object Visibility

You can change the display of modelled objects by selecting one of the following options:

• All - All loaded objects are constantly displayed•

• Disabled - No objects are displayed•

• Selected and Hovered - Displays objects only when they are selected in the Project Components Browser or•
when hovering the mouse over an object in the BubbleView

Modelled Object Opacity

This option enables users to control the opacity of the loaded modelled objects in the BubbleView. Move the
slider to the right to make the objects more opaque. Move the slider to the left to make the objects more
transparent.
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Modelled Object Fading

Alter to adjust the object fading distance in Bubbleviews.

If set at the max level, user has a full view of objects that are 20 cms or more behind point data.

If set at the mid level, user can view objects that are 20 cms behind point data with medium clarity.

If set at the min level, user can view objects that are 20 cms behind either partially or zero visibility.

Always Show Benchmarks in BubbleView

Use this option to control the display of Benchmarks in the BubbleView.

Sidebar Options
Auto-hide sidebar

This keeps the Project Component Browser (Sidebar) hidden after use if selected. When set, the Project
Components Browser will be switched off when the user interacts with a BubbleView. This is switched off by
default.

Confirm entity deletion

Turning this option off will stop displaying the confirmation window asking the user to confirm they wish to
delete an entity (Markup or measurement).

Solid Point Options
Demolished Points

Demolished points can be Hidden, Highlighted or Shown. If a project has demolished points, this option controls
how they are displayed when viewing in Solid Point mode through the Context Viewer.

Graphical Quality

Graphical Quality controls how many Solid Points are loaded into memory and the size of the points. This can be
altered based off performance of a dataset. When moving through a large Solid Point Cloud, the graphical
performance can be more noticeable as Viewer loads points into the scene. Once stationary the points will load
into to give a better representation of the graphical quality.
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Point Shape

This option enables you to control if your points are displayed as a Circle, Shaded Circle or a Square.

Background

This option helps you control your background in the context viewer, enabling you to view lighter points on a
dark background and darker points on a light background. The Environment option helps you view a basic
environment. The drop-down options include:

• Dark•

• Light•

• Environment•

The background changes depending on what options you have selected.

Export Entities

This feature enables the user to export a .csv file containing selected project data.

Select the relevant box for each type of project entity you wish to export and select Download. This will create
and save the .csv file to the download location specified on your machine.

The .csv file is separated into sections depending on which entities have been selected for export. For each entity
information such as name, type, positional information and a Sharelink. Upon pasting the Sharelink into a
supported browser, Viewer will open the closest/best scan and look at the respective entity (valid authorisation
required).

The exported .csv will respect the units set in the user’s .

The .csv filename will contain the Viewer project ID and the date that it was exported.

Project Administration

Selecting the Project Administration option will open a separate tab in your browser and take you to the Project
Administration page.

For information on how to use the Project Administration page, select the Help button on the title bar.
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Measurements

Viewer always connects back to the master AVEVA Point Cloud Manager dataset for measurements. This can be
seen as a simple terminal onto a potentially huge point cloud offering sub-millimeter density, operational speed
and the availability of an unlimited number of project scans. This means that any measurement interaction
through a Viewer session has AVEVA Point Cloud Manager providing a detailed response to queries in moments.
Measurements taken are therefore not ‘approximate’, and should be viewed as highly accurate, and in line with
the expectations of engineering users of AVEVA Point Cloud Manager.

When using a Viewer project offline, the central project database will be updated when a user synchronizes their
work. Additionally, users may not be able to extract an accurate coordinate when operating offline. In these
situations, temporary field measurements may be fully resolved when back online. This guarantees the accuracy
within Viewer sessions related to the full laser surveyed point cloud.

Measurement functions are accessed through the Viewer Tools "Pill" Menu. To open the Tools Menu click/tap
the desired icon at the bottom of the BubbleView as shown below.

Measurements will be created in the group that is currently selected in the Properties Panel on the right hand
side of the interface. If no group is selected in the Properties Panel, the Measurement is created at the top-level
Measurement node.

To access the Properties Panel, select the Show Properties Panel icon at the top-right of the Viewer interface.

Measure a Single Point

To measure a single point:

• Click/tap the ‘Point Measurement’ tool from the Tools "Pill" Menu then click/tap the point you wish to•
measure.
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The point coordinate value will be returned to the Viewer user directly in the BubbleView.

Please note that measurements cannot be placed as accurately on mobile devices, due to the use of ‘finger
picking’. If this is an issue, measurements can be repeated & replaced when back in a suitable environment.

The Properties Panel has provision for the user to input a relevant name for the measurement. After the input is
given, other ‘live’ users of the project will see this following a project refresh.

When the measurement has been committed to the central database, a user may delete or rename it using the
tools shown below. You can turn the deletion confirmation dialogue off in the Options menu under Sidebar >
Confirm Entity Deletion.

To select multiple measurements for deletion, select the Toggle multi select option.

Measure Between Two Points

Viewer users may also measure between two points. When the Point to Point Measurement is chosen, the user
will be prompted to select both points within the BubbleView. Following this, the points will be accurately
resolved on screen using the laser point cloud, and the results displayed within the BubbleView.
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To measure between two points,

• Click/tap the ‘Point to Point’ tool from the Tools "Pill" Menu then click/tap the start and end points for the•
measurement calculation.

The displayed results include the two-point coordinates selected, the overall distance and the delta values
between them.

As with the single point measurement the point to point measurement will be shown in the Properties Panel.
When the input is given, other ‘live’ users of the project will see this following a project refresh.

When the measurement has been committed to the central database, a user may delete using the Delete icon,
after expanding the measurement. You can turn the deletion confirmation dialogue off in the Options menu
under Sidebar > Confirm Entity Deletion.

Measure a Pipe Diameter

This function enables the user to quickly determine the diameter of a pipe. The user defines a line along the path
of the pipe to be measured and its diameter is then calculated. Results are displayed in the BubbleView showing
the diameter as an annotation, with a translucent pipe aid overlaid for clarity. The user can visually check the
accuracy of results before adding a project measurement label in the Properties Panel.

Note: This feature is not available when in offline mode.

To measure a pipe diameter:

• Click/tap the ‘Pipe Diameter’ tool from the Tools "Pill" Menu then click/tap the start and end of the desired•
pipe.

Point Cloud Manager will then calculate the ‘best fit’ cylinder using the path between the two points. Please
note that these points have no direct impact with the results but offer a directional guide to the Point Cloud
Manager fitting algorithm. When the calculation has been processed, a 3D representation of the pipe will
appear on screen.

The results are displayed in the BubbleView.
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As with the other measurements the point to point measurement will be shown in the Properties Panel. When
this has been input, other ‘live’ users of the project will see this following a project refresh.

When the measurement has been committed to the central database, a user may delete or rename it using the
tools. You can turn the deletion confirmation dialogue off in the Options menu under Sidebar > Confirm Entity
Deletion.

Note: All measurements listed in the Properties Panel can be located in the BubbleView by selection with a
single click/tap. All visible measurements in the BubbleViews are also selectable by clicking/tapping on the
measurement in the BubbleView which will highlight the measurement in the Properties Panel.

If there is insufficient data to calculate a measurement, the user will be informed through an error message.

Measurement Feedback

In practice, all measurements are returned to the user within the active BubbleView. These are colour coded to
represent the different axes, where X/Easting is red; Y/Northing is green, and Z/Elevation is blue.

You can copy the contents of these measurement callouts to the clipboard, to include in documents and
spreadsheets. You can access this by tapping and holding/right clicking the measurement/Markup callout.

The user has control over the copied information through the form. To copy a part of the measurement
information to the clipboard, simply click on it.

To save all the measurement/Markup information to a text file select Save.
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3D Markups & Fast Tag Display

3D Markups and Fast Tags can be created directly in Viewer or AVEVA Point Cloud Manager 4.3 onwards.

Viewer projects use the same AVEVA Point Cloud Manager dataset that is used for design. In practice, this can be
a copy of the data, or the same data which is used for both purposes. AVEVA Point Cloud Manager has authoring
tools to create 3D Markups and add Fast Tags from coordinate/description spreadsheets. There is also provision
to add and maintain project labels. These can be adapted to suit the needs of the project, but could include
routine maintenance tasks, inspection items, discussion points and so on.

Please refer to the AVEVA Point Cloud Manager Server section for further information about these possibilities.
This section will focus primarily on the tools available through a Viewer session.

Markups can be made directly within Viewer. If field Markups are defined these can be edited further upon
return to the office if needed. For example, anomalies can be quickly identified and ‘marked-up’ on a tablet in
the field, and reworked when connected back to the main project.

One important feature about the Markup process is that all markups are stored as 3D volumetric shapes in the
project database. This means that they will be automatically displayed in any BubbleView that can conceivably
see them.

Markup functions are accessed through the Viewer Tools "Pill" Menu. To open the Tools Menu:

• Click/tap the Markup icon at the bottom of the BubbleView as shown below.•

You can create markups in the 3D Context Viewer as well as BubbleViews.

Creating a Point Markup
1. Select the Point Markup button from the Tools "Pill" Menu.1.
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2. Click and release on a point of interest, then move the mouse cursor to drag the sphere to an appropriate2.
size. Click again to complete.

3. Press and hold your finger on a point of interest in the BubbleView; then drag away to control the size of the3.
spherical Markup. Release to complete.

When Markups are committed to the database they appear in the Properties Panel and turn green in the
BubbleView.

Markups are created in the group that is currently selected in the Properties Panel. If no group is selected in
the Properties Panel, the markup is created at the top-level 3D Markups node.

4. To delete the Markup, select Delete.4.

5. To edit the Markup, select Edit.5.

You can rename the Markup and edit the labels/URLs associated with the Markup. You can also change the
Markup colour.

6. To add a new label/URL, select Edit against a point markup and enter the information in the Enter Label or6.
URL field then select Add. To delete a label/URL select the cross next to that label/URL.

7. To add link text to a URL, simply enter the text to be displayed and select Add.7.

Please note that URL text shortening is not available for projects hosted on Desktop.

8. When the desired changes have been made, select Submit to commit these changes to the project. To exit8.
this dialog without committing any changes, select Cancel or select the cross at the top-right-corner of the
dialog.
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To select multiple markups for deletion, select the Toggle multi select option at the top-right corner of the
markup window.

Creating a Box Markup
1. Select the Box Markup button from the Tools "Pill" Menu.1.

2. Click and release on a point of interest, then follow the prompts at the top of the Viewer interface as shown2.
below.

3. Press and hold your finger on a point of interest in the BubbleView; then drag follow the prompts at the top3.
of the Viewer interface as shown below.

When markups are committed to the database, they appear in the Properties Panel and turn green in the
BubbleView.

Markups are created in the group that is currently selected in the Properties Panel. If no group is selected in
the Properties Panel, the markup is created at the top-level 3D Markups node.

4. To delete the markup, select Delete.4.

5. To edit the markup, select Edit.5.

You can rename the Markup and edit the labels/URLs associated with the Markup. You can also change the
Markup colour.

6. To add a new label/URL, simply enter the information in the Enter Label or URL field and press Enter.6.

7. To delete a label/URL, select the cross next to that label/URL.7.

8. To add link text to a URL, simply enter the text to be displayed and select Add.8.

Please note that URL text shortening is not available for projects hosted on Desktop.

9. When the desired changes have been made, select Submit to commit these changes to the project. To exit9.
this dialog without committing any changes, select Cancel or select the cross at the top-right-corner of the
dialog.

Editing a Markup
To edit a Markup once it has been created:

1. Right-click on the desired markup. Alternatively, select the arrow next to the markup in the Properties Panel1.
and then select Edit. This applies to both box and point Markups.
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2. Tap and hold, then release on the desired Markup.2.

This displays arrows on the faces of the selected markup.

Choose between resizing and repositioning the markup by using the buttons at the bottom-right of the
interface.

3. Click and release the arrow corresponding the face you wish to edit. Moving the mouse cursor will move/3.
resize the markup in the specified direction. Click to finish.

Further adjustments can be made at this point in the same manner. When you are happy with the new size/
position, click away from the markup to commit to the project database.

4. To cancel editing, press Esc or right-click to return to the original markup size and position.4.

5. Tap and drag on the arrow corresponding the face you wish to edit. Release to finish.5.

Further adjustments can be made at this point in the same manner. When you are happy with the new size/
position, tap away from the markup to commit to the project database.

6. To cancel editing, press/tap on the blue X on the callout at the top of the screen to return to the original6.
markup size and position.

Markup Display in the Floorplan
Markups/Fast Tags can be quickly identified in the floorplan. Users double-clicking/tapping on a Markup in the
Properties Panel will be able to identify all the close scans to that object. This makes the process of finding
individual Markups/tags on often large complex facilities straightforward.
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Simply click/tap on the nearest viewpoint to view the Markup.

External Document, URL and Drawing Linking
Markups can be assigned external links to documents and URLs either in AVEVA Point Cloud Manager or directly
in Viewer. Users can quickly call up inspection method sheets, diagrams, or equipment specification information.
Several external links can be applied to a single 3D Markup to aid the different sets of people reviewing a
particular item.

To add a link to a Markup:

1. Select Edit at the side of the markup name in Properties Panel. Enter in the desired URL and select the Add1.
button to commit this to the project database.

2. To add link text to a URL, enter the text to be displayed and select Add.2.

3. When the desired changes have been made, select Submit to commit these changes to the project. To exit3.
this dialog without committing any changes, select Cancel or select the cross at the top-right-corner of the
dialog.

The link will appear under the specified Markup with a yellow link icon next to it. Clicking on any of the links
(when not in editing mode) opens the link in a new tab.

4. To remove a URL, select the X at the end of the URL when in editing mode and select Submit.4.

Note: Any invalid URLs will be displayed in red.

Adding Photos to Markup
When a Markup has been created, photos can be added to the Markup to help the user see more detailed
information.

To attach photos to a Markup:

1. Select the markup in the Properties Panel and select the +New button. This opens a file browser where you1.
can select the images you wish to upload to the selected Markup.

2. Select OK to upload the selected images. Currently supported formats are: .png, .jpg, .jpeg, .gif, .ico, .bmp,2.
and .jfif.

Note that you can select multiple images at once.

When uploaded, a thumbnail of each image is displayed when the Markup is selected in the sidebar.
Selecting an image in the sidebar opens the image in the Viewer interface.

3. To expand the image size to the full Viewer view size or the full image size (whichever is smaller), click on the3.
Maximize button. When maximized, select Restore Down to return the image to its previous size.

4. To close the image window, simply press the × in the top right corner.4.

Please note that viewing attached images is not available when using a Viewer offline session.

Please note that this feature is not available when projects are hosted on Desktop.
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You can also add videos of the formats .mp4 and .webm with a size limit of less than 100 MB. The procedure to
add videos is the same as that of adding photos to a markup.

Deleting Photos/Videos From Markups
To delete a photo or a video from a Markup, select Delete and then select Yes on the confirmation dialog to
confirm you wish to delete the selected photo or video. The thumbnail will then be removed from the sidebar.

Grouping Markups & Tags
The Properties Panel will support the Markup hierarchy set by the administration team. This requires access to
the master dataset through an AVEVA Point Cloud Manager session. The illustration below shows the presence
of a Markup category.

It is desirable to configure several repositories to store categorized markups. This could reflect the needs of
differing users of Viewer, ranging from inspectors; maintenance operatives; designers and operations staff.
Alternatively, design annotations could be compartmentalized into structural; HVAC; electrical and piping etc. If a
grouping structure is not adopted, all the markups & Fast Tags will be listed at the same level in the Properties
Panel.

When creating new Markups inside Viewer, the markup is created in whichever group is currently active in the
Properties Panel. If no Markup group is active or if a Measurement group is active, newly created markups are
created at the top level of the 3D Markups in the Properties Panel.

Markup Labels
All Markups can be assigned ‘labels. These can be added directly in Viewer or by interaction with the master
project through an AVEVA Point Cloud Manager session. Labels enable users to add important additional
information to a 3D Markup. Labels can be seen as work lists that require user input/action. They are searchable
and simple to use.

There are many different use case scenarios for these. Two examples are listed below.

Predefined Markups and labels by a project administration team using AVEVA Point Cloud Manager
Maintenance and Inspection. All process valves are marked up and assigned several labels. These range from
‘condition’, ‘inspection date’, ‘operational status’, and ‘manufacturer’. Personnel conducting site visits can search
for relevant labels; locate in the images and on site; then clear or alter the relevant states of these items. These
will then be synchronised with the project database upon return.

Field Markups by staff visiting site
A Maintenance Engineer is conducting a routine site walkthrough. An anomaly was witnessed which may
develop into a serious incident if not rectified. The item was located in the Viewer BubbleView and a Markup
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was made. This was then given an ‘anomaly’ attribute, and ‘severity’. These are then collated and actioned by
project staff when committed to the annotation database upon return.

Adding Labels
1. Select Edit on the Markup being labelled.1.

The markup expands to allow the user to add all necessary labels. Viewer supports single or multiple labels
within the project.

2. Select Enter Label or URL, then type the required name/description. To commit the label to the Viewer2.
project database select Add or press Enter on the keyboard.

3. If several labels need to be added at the same time it is preferable to follow this workflow:3.

a. Type label > [Enter]a.

b. Type label > [Enter]b.

c. Type label > [Enter] etc.c.

4. Then select Submit. This will keep all interactions local until all the labels are uploaded to the master project4.
database in one pass. When the project database has been updated, the labels are displayed with the
marked-up item.

Inspection example workflow
• Search for inspection items for this site visit.•

• Select the name of the parent Markup and locate in the floorplan.•

• Using the floorplan as a guide, walk to the item to perform the inspection. Then call a near BubbleView from•
the Viewer project and look at the requirements described by the labels and/or external linked
documentation.

• For the example above: if the inspection was passed, the inspector could add an inspection completed/date/•
recharged label or additional information to be passed back to the project coordinator. These can then be
actioned by the correct personnel or linked through to external Asset Management Systems as appropriate.

Markup Categories
To support better markup visibility and to improve the ability to perform inspection tasks, Viewer enables you to
organise your markups into different category types. You also have the ability to add icons to each category type.
However, you must have Administrator permissions to create categories and category groups.

After you have created your markups, you can assign a category to each markup through the 3D Markups tab at
the top-level node in the Properties Panel by selecting the Category drop-down arrow as shown below.
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Your category is displayed in the BubbleView at the center of your markup.

The background colour against the category name indicates the group that it belongs to.

To create a category/category group:

1. In the Properties Panel, select the Categories node.1.

2. Then, select the Add icon against the Categories node.2.

3. In the Create categories window that is displayed, you have the option of creating a category under a new3.
group or under an existing group.
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Viewer enables the option of assigning a background colour for each of your categories. You can also select
an icon for each category from the Search icons drop-down list.

4. After you have entered all the details,select the Create button. You will then be able to view your category4.
under the specified group. You can also drag and drop each category in between groups.

5. To filter the categories, turn off/on the check-box against a category/category group.5.

6. To edit or delete a category, select the three dots icon.6.
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Filtering Options Within Viewer

Viewer projects have the capability to hold and present many forms of data to users. Users are reminded that
categories can be created within the master dataset by project administration staff using AVEVA Point Cloud
Manager. This enables similar information to be grouped together, and thereby reduces the amount of data
initially presented to Viewer users. Information stored in the Viewer database can filtered by name, whether it is
in the general list or in a defined project category.

Searching and Filtering of Scans, Measurements, & Markups

Start typing in the filtering box to reduce the number of items displayed to the user for clarity.

Markup Label Filtering

Label filtering can be applied to reduce the information provided to the Viewer user.
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Markups present in the Properties Panel may have labels associated with management or inspection of the plant
or facility. To find all Markups that contain a specific label, simply enter the desired search term in the Search
box. Viewer will automatically remove any markup that does not contain labels matching the search term.

Note that filtering will also return any markups with associated photos that match the specified term.

Scan Date Filtering

If one or more of the scans within the project have scan metadata, you may filter the list of scans by date. Simply
fill in the minimum and maximum date using the fields (these are displayed when the Project Components
Browser is displaying the dataset or scan list) and only scans captured between these dates are displayed.
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